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Instructor Notes

Presentation:
120 Minutes

Lab:
60 Minutes

This module provides students with the knowledge needed to create high-
performance data access applications in Microsofte Visua Basice .NET.

It begins with a discussion about the need for ADO .NET and the benefits it

brings to the development environment. Students will then learn about
ADO .NET providers and the objects they supply.

Students will then learn about the DataSet object. Students will learn how to
add, update, and delete data by using it. Students will then learn how to use data
designers and data binding in Microsoft Windowse Forms and Web Forms.
Finally, students learn how Extensible Markup Language (XML) integrates
with ADO .NET.

After completing this module, students will be able to:

m List the benefits of ADO .NET.

n Create applications by using ADO .NET.

m List the main ADO .NET objectsand their functions.

»  Use Microsoft Visua Studios .NET data designers and data binding.
m Explain how XML integrates with ADO .NET.



iv Module 8: Using ADO .NET

Materials and Preparation

This section provides the materials and preparation tasks that you need to teach
this module.

Required Materials

To teach this module, you need the following materials:
m  Microsoft PowerPointe file 2373A_08.ppt

= Module 8, “ Usng ADO .NET”

m Lab 8.1, Creating Applications That Use ADO .NET

Preparation Tasks
To prepare for thismodule:

= Read al of the materials for this module.

= Read the instructor notes and the margin notes for the module.
= Practice the demonstrations.

m  Complete the practice.

»  Complete the lab.
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This section provides demonstration procedures that will not fit in the margin
notes or are not appropriate for the student notes.

Retrieving Data Using ADO .NET

I To prepare for the demonstration

1. Open the DataReaderDemo.sin solution in the install folder\DemoCode\
Mod08\DataReader\Starter folder.

2. View the code behind the Display button, and explain the variable
declarations.

£ To add code to the form

1. Locate the comment “ Add code to open connection,” and add the following
lines of code:

conSQL.ConnectionString = "data source=localhost;initial
catalog=cargo;integrated security=true;"
conSQL .Open( )

2. Locate the comment “ Add code to set CommandText and Connection
properties of the command,” and add the following lines of code:

comSQL .CommandText = "Select FirstName, LastName from
Customers"
comSQL .Connection = conSQL

3. Locate the comment “ Add code to execute the command,” and add the
following line of code:

readerSQL = comSQL.ExecuteReader( )

4. Locate the comment “ Add code to loop through the records, add each to the
listbox,” and add the following lines of code:

Do While readerSQL.Read
IstCustomers. ltems.Add

(readerSQL. Item(""FirstName'™) .ToString & " ™ &
readerSQL. I'tem(*'LastName'™) .ToString)
Loop

£ Totes the code

1. Run the application, and click Display. You should see alist of customersin
the Cargo database.

2. Quit the application, and quit Visua Studio .NET.
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Using the Data Form Wizard

£ Torun thewizard

1

4.

Open Visua Studio .NET, and create a new Windows application project in
the install folder\DemoCodeM od08\DataFormWizard folder.

In the Solution Explorer, click WindowsApplicationl. On the Project menu,
click Add New Item, select Data Form Wizard, and click Open.

Run the wizard, using the information provided in the following table.
Where no details are specified, use the defaults.

Setting Value
New dataset name dsCargo
Which connection shouldthewizard New Connection
use?
Server name localhost
Logon Integrated security
Database name Cargo
Which items do you want to access? Cusgtomers
Invoices
Réationship name CustinvRe
Parent table Customers
Key Customer|D
Child table Invoices
Key Customer|D

How do you want to display your data? = Singlerecord in individual controls

Save the project.

£ Totest theform

1.

o~ DN

In the project Properties window, change the Startup object to DataForm1.
Run the application.

Click Load to load the data into the form.

Change the CompanyName field to Microsoft, and then click Update.

Click Add, and enter some sample data (use 2222 for the CustomerID).

Move away from that record, and verify that there are now 22 records in the
form.

Move back to your new record, and click Delete. Verify that there are now
21 records in the form.

Quit the application.



Delivery Tip

Ensure that you add the
item to the project, not to the
solution, or the
demonstration will not
function as documented.
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Using XML Schema
£ Toadd the XML fileto the project

1

Open the XMLDataDemo.sln solution in the install folder\DemoCode\
Mod08\XML Data\Starter folder.

In the Solution Explorer, click XML DataDemo. On the Project menu,
click Add Exigting Item. Change the Files of type to Data Files (*.xsd,
* xml), select Customer s.xml, and then click Open.

Open Customers.xml and review the data extracted from the Cargo database.

£ To generate a schema
1. Onthe XML menu, click Create Schema.
2. Point out that an xmlns attribute has been added to the root element

identifying the schema.

3. Review both the Schema view and XML view of Customers.xsd.

4. Inthe Schema view, change the data type for the ID attribute to integer.

Show the corresponding change in the XML view.

£ To validate data

1.

In the XML view of Customers.xml, rename the <Pword> element
belonging to the first customer to <Password>. Remember to aso change
the closing tag.

2. Onthe XML menu, click Validate XML Data.
3. Review the tasks created in the Task List and explain the meaning of each

one.

4. Change the element name back to <Pword>.

5. Onthe XML menu, click Validate XML Data. Point out that the message

in the status bar stating that no validation errors were found.



viii Module 8: Using ADO .NET

Module Strategy

Use the following strategy to present this module:

ADO .NET Overview

This lesson provides an overview of ADO .NET, including the advantages it
provides. Some students who are familiar with the Microsoft .NET

Framework will be aware of these benefits, but others will need to know
why ADO .NET isworth learning.

.NET Data Providers

This lesson introduces the four main objects within the data providers. The
first two objects this lesson describes, Connection and Command, are

similar to their Microsoft ActiveXe Data Objects (ADO) counterparts, but
be sure to point out the differences needed in the code.

The third object, the DataReader, is similar to the default ADO cursor, the
firehose cursor. Students often find this similarity helpful when they are
learning about the DataReader.

The fourth object, the DataAdapter, is primarily used to populate DataSets
and to update the data source from DataSets. Simply point out its syntax

here because you will provide a thorough explanation of its usesin the next
lesson.

The DataSet Object

This lesson begins with a review of disconnected data. Again, if students
seem to be aware of theissues, then only explain the topic briefly.

This lesson then describes how to use the main objects within a DataSet:
DataT able objectsand DataRelation objects. Students might try to equate
a DataSet with an ADO Recordset, and you need to ensure that they
understand that a DataSet contains a collection of tables that are sometimes
related.

Finally, you will explain how to update data in the DataSet and how to
propagate those changes to the data source. Students need to be aware that
the data is disconnected, which means that any changes the students make
are local and that they need to explicitly pass the changes back to the source.

Data Designers and Data Binding

This lesson covers some of the new graphical user interface (GUI) features
for data access in Visual Basic .NET. Remind students that all of these
features simply automate the coding that they have learned so far, and that

they can create things by using the tools and then customize the code for
their own purposes.

The lesson also covers how to use data binding in both Windows Forms and

Web Forms. These techniques are distinctly different from those of Visua
Basic 6.0, so ensure that you cover the topics adequately.
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XML Integration

This lesson relies on the students' knowledge of XML. Ensure that they
have some understanding of it before embarking on the topics, or you may
confuse them. The main things they need to know are how an XML
document is hierarchical, what it looks like, and why XML is so important
for developers.

The topics about schemas should be relatively easy because students will
either be aware of database or XML schemas, and the importance of
validation. The final topic is only designed to explain the links between
DataSets and XmlDataDocument. Do not get involved in along discussion
about XmlDataDocument, because it is not necessary to be able to use
ADO .NET.

iX






Overview

Topic Objective

To provide an overview of
the module topics and
objectives.

Lead-in

In this module, you will learn
how to use ADO .NET from
Visual Basic .NET.

Module 8: Using ADO .NET

m ADO .NET Overview

» .NET Data Providers

m The DataSet Object

m Data Designers and Data Binding

= XML Integration

1

In this module, you will learn how to use ADO .NET from Microsofte

Visual Basice .NET version 7.0. You will learn about the Microsoft .NET
providers included in the .NET Framework and about how to use the DataSet
object. You also will learn how to use the Microsoft Visual Studioe .NET data
designers and how to bind data to Microsoft Windowse Forms and Web Forms.
Finaly, you will learn about the integration of Extensible Markup Language
(XML) with ADO .NET.

After completing this module, you will be able to:

List the benefits of ADO .NET.

Create applications using ADO .NET.

List the main ADO .NET objects and their functions.
Use Visual Studio .NET data designers and data binding.
Explain how XML integrates with ADO .NET.
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€ ADO .NET Overview

Topic Objective

To provide an overview of
the topics covered in this
lesson.

Lead-in
ADO .NET provides many

enhancements upon ADO.

= Introduction to ADO .NET

m Benefits of ADO .NET

ActiveX @ Data Objects for the .NET Framework (ADO .NET) provide many
enhancements for accessing data in a disconnected environment. ADO .NET

contains objects that are similar to those of ADO, alowing you to update your
skills easily.

In this lesson, you will learn where ADO .NET iswithin the NET Framework,
and about the benefits ADO .NET provides.

After completing this lesson, you will be able to:

m  Describe the role of ADO .NET in the .NET Framework.
= List the major benefits of ADO .NET.
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Introduction to ADO .NET

Topic Objective

To discuss ADO .NET and
its place in the .NET
Framework.

Lead-in
ADO .NET is a component
of the .NET Framework.

| AsPNeT | | Windows Forms |

Class Framework

| Drawing| | XmL| DataI Q== DO NET

| Common Language Runtime |

| System Services |

ADO .NET isaset of classes that allow .NET -based applications to read and

update information in databases and other data stores. Y ou can access these
classes through the System.Data namespace provided by the .NET Framework.

ADO .NET provides consistent access to awide variety of data sources,
including Microsoft SQL Server™ databases, OLE DB-compliant databases,
non-relationa sources such as Microsoft Exchange Server, and XML
documents.

Earlier data access methods, such as Data Access Object (DAO), concentrate on
tightly coupled, connected data environments. One of the main purposes of
ADO .NET isto enhance the disconnected data capabilities. Many of the
common ADO objects that you have worked with correlate to ADO .NET
objects, athough there are also many new classes to enhance the data access
model.

ADO .NET uses .NET data providersto link your applications to data

sources. .NET data providers are similar to the OLE DB providers used in ADO,
athough they are primarily concerned with moving data into and out of a
database rather than providing interfaces over al of a database’ s functiondlity.

ADO .NET includes two .NET data providers:

m .NET data provider for SQL Server
For use with SQL Server 7.0 and later.
s .NET data provider for OLE DB
For use with data sources exposed by OLE DB.

The ADO .NET data providers contain tools to allow you to read, update, add,
and delete data in multitier environments. Most of the objects in the two
libraries are similar and are identified by the prefix on their name. For example,

SglDataReader and OleDbDataReader both provide a stream of records from
a data source.
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Benefits of ADO .NET

Topic Objective
To discuss the benefits of
using ADO .NET.
Lead-in m Similar to ADO
ADO .NET provides : :
many benefis (o the m Designed for Disconnected Data
Visual Basic .NET = Intrinsic to the .NET Framework
developer.
= Supports XML
ADO .NET provides many benefits to experienced Visual Basic developers,
including:
= Similar programming model to that of ADO
This makes it easy for Visua Basic developers who are familiar with ADO
to update their skills. You can still use ADO in Visua Basic .NET, so you
can keep existing code, but use the features of ADO .NET in new projects.
m Designed for disconnected data
Del T ADO .NET is designed for working with disconnected data in a multitier
Yc?ul\r/rgy finldpth at you need environment. It uses XML as the format for transmitting disconnected data,
to expand on the problems which makes it easier to communicate with client applications that are not

that were faced when
transmitting data as COM
objects, such as
dependency on a Windows
based client over a local
area network.

based on Windows.
Intrinsic to the .NET Framework

Because ADO .NET isintrinsic to the NET Framework, you have all the
advantages of using the .NET Framework, including ease of cross-language
development.

Supports XML

ADO and XML have previously been incompatible: ADO was based on
relational data, and XML is based on hierarchica data. ADO .NET brings
together these two data access techniques and alows you to integrate

hierarchical and relational data, as well as alternate between XML and
relational programming models.
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& NET Data Providers

Topic Objective

To provide an overview of
the topics covered in this
lesson.

Lead-in

The .NET Data Providers
allow access to specific
types of data sources.

m Using the Connection Object

= Using the Command Object

= Using the Command Object with Stored Procedures
m Using the DataReader Object

m Using the DataAdapter Object

The .NET data providers alow access to specific types of data sources. Y ou can
use the System.Data.SQL Client namespace to access SQL Server 7.0 and later
databases, and the System.Data.OL EDB namespace to access any data source
exposed through OLE DB.

Each of these providers contains four main objects that you can use to connect
to a data source, read the data, and manipulate the data prior to updating the
source.

After completing this lesson, you will be able to:
» Usethe Connection object to connect to a database.

s Usethe Command object to execute commands and, optionally, to return
data from a data source.

» Usethe DataReader object to create aread-only data stream.

s Usethe DataAdapter object to exchange data between a data source and a
DataSet.
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Using the Connection Object

Topic Objective
To introduce the ADO .NET
Connection object.

Lead-in

You can use the
Connection object to
connect to a specific data
source.

m SglConnection

Dim conSQL As Sql Cient.Sgl Connection

conSQ@ = New Sgl Cli ent. Sql Connection( )

conSQL. ConnectionString = "Integrated Security=True;" & _
"Dat a Source=Local Host ;I nitial Catal og=Pubs;"

conSQL. Open( )

m OleDbConnection

Di m conAccess As O eDb. O eDbConnecti on
conAccess = New A eDb. A eDbConnection( )
conAccess. ConnectionString = "Provider=
M crosoft.Jet. OLEDB. 4. 0; Dat a Sour ce=c: \ NW nd. MVDB"
conAccess. Open( )

To connect to a database, you set the connection type, specify the data source,

and connect to the data source. When you are finished working with the data,
you close the connection.

1. Set the connection type.

Y ou can use the Connection object to connect to a specific data source.
Y ou can use either the SqlConnection object to connect to SQL Server

databases or the OleDbConnection object to connect to other types of data
Sources.

2. Specify the data source.

After you set the connection type, you use a ConnectionString to specify
the source database and other information used to establish the connection.
The format of these strings differs dlightly between the SglClient
namespace and the OleDb namespace.

3. Connect to the data source.
Each object supports an Open method that opens the connection after the

connection properties have been set, and a Close method that closes the
connection to the database after all transactions have cleared.

SglConnection

The SglConnection object is optimized for SQL Server 7.0 and later databases

by bypassing the OLE DB layer. It is recommended that you use this object, not
OleDbConnection, when working with these types of data sources.



Delivery Tip

If you demonstrate this
code, ensure that
NWind.mab is in the
specified path.
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The SQL Client .NET Data Provider supports a ConnectionString format that
issimilar to ADO connection strings. This consists of name-value pairs
providing the information required when connecting to the data source. The
following table lists the most commonly used pairs.

Keyword name Description Default value
Connection Timeout Length of time to wait for a 15seconds
(or Connect Timeout) connection to succeed before
returning an error
Initial Catalog Name of the database None
User ID SQL Server logon account None
(if using SQL Server security)
Password SQL Server password None
(or Pwd) (if using SQL Server security)
Data Source Name or network address of SQL None
(or Server Server
or Address
or Addr
or Network Address)
Integrated Security Whether the connection is a secure Fdse

(or Trusted_Connection)  connection

The following example shows how to connect to a SQL Server database by
using the SQL Client .NET Data Provider:

Dim conSQL As SqlClient.SqlConnection

conSQL = New SqglClient.SqlConnection( )
conSQL.ConnectionString = "Integrated Security=True;" & _
"Data Source=LocalHost;Initial Catalog=Pubs;"
conSQL.Open( )

OleDbConnection

The OleDbConnection object exposes methods similar to those of the

SglConnection object, but certain data sources will not support al the available
methods of the OleDbConnection class.

The OLE DB .NET Data Provider uses a ConnectionString that isidentica to

that of ADO, except that the Provider keyword is now required, and the URL,
Remote Provider, and Remote Server keywords are no longer supported.

The following example shows how to connect to a SQL Server database by
using the OLE DB .NET Data Provider:

Dim conAccess As OleDb.OleDbConnection

conAccess = New OleDb.OleDbConnection( )
conAccess.ConnectionString =
"Provider=Microsoft.Jet.OLEDB.4.0;Data Source=c: \NWind.MDB""
conAccess.Open( )

Note The examplesin the remainder of this module use the SQL Client
namespace. For more information about the OLE DB namespace, search for
“OleDBConnection” in the Visual Basic .NET documentation.
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Using the Command Object

Topic Objective

g%;ﬂgff#gig}‘;tmo NET = Two Waysto Createa = Three Ways to Execute a
, ' Command: Command:

Lead-in

Once you have established e Command constructor e ExecuteReader

a connection to your data

source, you can use the e CreateCommand e ExecuteScalar

Command object to method - \

execute SQL statements. e ExecuteNonQuery

e ExecuteXMLReader

Dim commSQL As Sql C i ent. Sql Conmand

conmSQL = New Sqgl Cli ent. Sql Command( )

conmBQL. Connection = conSQL

comBSQL. CommandText = "Sel ect Count (*) from Authors"
MessageBox. Showm cormSQL. Execut eScal ar ( ). ToStri ng)

You can use the ADO .NET Command object to execute commands and,
optionally, to return data from a data source. Y ou can use the SqlCommand

with SQL Server databases and the OleDbCommand with all other types of
data sources.

Creating Commands
Y ou can create a command in one of two ways:

»  Usethe Command constructor, passing the Connection name as an
argument.

m  Usethe CreateCommand method of the Connection object.

Y ou can usethe CommandText property of the Command object to set and
retrieve the SQL statement being executed. Y ou can use any vaid SQL

statement with the specified data source, including data manipulation, definition,
and control statements.



Delivery Tip

Do not go into detail about
the DataReader object at
this time because it will be
covered later in this lesson.
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Executing Commands

Y ou can only execute a Command within avalid and open connection. The
Command object provides three methods that you can use to execute
commands:

» ExecuteReader

Use this method when the query will return a stream of data such as a Select

statement returning a set of records. This method returns the records in a
SglDataReader or OleDbDataReader object.

m  ExecuteScalar

Use this method when the query will return a singleton value; for example, a
Select statement returning an aggregate value. It executes the query and
returns the first column of the first row in the result set, ignoring any other
data that is returned. This method requires less code than using the

ExecuteReader method and accessing a single value from the
SqlDataReader object.

m  ExecuteNonQuery

Use this method when the query will not return aresult; for example, an
Insert statement.

m ExecuteXML Reader

Use this method when the query includes avalid FOR XML clause. Thisis
only valid when using the SQL Command object.

The following example shows how to use the Command object to query a
database and retrieve data:

Dim conSQL As SqlClient.SqglConnection

conSQL = New SqlClient.SqglConnection( )
conSQL.ConnectionString = "Integrated Security=True;" & _
"Data Source=LocalHost;Initial Catalog=Pubs;"
conSQL.Open( )

Dim commSQL As SqlClient.SqglCommand

commSQL = New SqlClient.SqlCommand( )

commSQL .Connection = conSQL

commSQL.CommandText = "'Select Count(*) from Authors"
MessageBox . Show(commSQL . ExecuteScalar( ).ToString)

This code determines how many rows are present in the Authors table of the
Pubs database and displays the result.
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Using the Command Object with Stored Procedures

Topic Objective
To discuss how to use the
Command object to

execute stored procedures. Create a Command Object

Lead-in

Many databases will contain
stored procedures that you
want to execute.

Set the CommandType to StoredProcedure
Use the Add Method to Create and Set Parameters

Use the ParameterDirection Property
Call ExecuteReader

Use Records, and Then Close DataReader

N o o B~ W D

Access Output and Return Parameters

You can also use the Command object to execute stored proceduresin a

database. Y ou may need to perform some additional steps when preparing the
Command to alow for the use of parameters in the stored procedure.

Use the following steps to execute a stored procedure with the Command

object:
_ _ 1. Createa Command object.
Delivery Tip
Talk through these steps 2. Set the CommandType property to StoredProcedure.
with respect to the code 3. Usethe Add method to create and set any parameters.
example below.
4. Usethe Parameter Dir ection property to set parameter type.
5. Cadll the ExecuteReader method.
6. Usethe DataReader object to view or manipulate the records, and close it

when finished.
7. Access any output and return parameters.



Delivery Tip

Do not go into detail about
the DataReader object at
this point because it will be
covered later in this lesson.
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The following example shows how to execute a stored procedure using
ADO .NET.

Imports System.Data.SqlClient

Private Sub Buttonl_Click(ByVal sender As System.Object, ByVal
e As System.EventArgs) Handles Buttonl.Click

Dim conSQL As SqlClient.SqlConnection

conSQL = New SqlClient.SglConnection( )
conSQL.ConnectionString = "Integrated Security=True;" & _
"Data Source=LocalHost;Initial Catalog=Pubs;"
conSQL.Open( )

Dim commSQL As SqlClient.SglCommand = New SqlCommand( )
commSQL .Connection = conSQL

commSQL .CommandType = CommandType.StoredProcedure
commSQL .CommandText = "‘byroyalty"

Dim paramSQL As New SqlClient.sqlParameter( _
"'@percentage’, SqIDbType.Int)

paramSQL.Direction = ParameterDirection.Input

paramSQL.Value = "'30"

commSQL . Parameters.Add(paramSQL)

Dim datRead As SqglClient.SqglDataReader
datRead = commSQL.ExecuteReader( )
Do While datRead.Read( )
MessageBox . Show(datRead(0) .ToString)
Loop
datRead.Close( )
End Sub

Tip If you are running a query that will only return one row, you can improve
the performance of your application by returning this data as output parameters
from a stored procedure.
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Using the DataReader Object

Topic Objective
To discuss how to use the
DataReader object.

Lead-in

The DataReader object
gives you fast, efficient
access to a stream of data.

m Reading Data

Dim commBQ. As Sqgl Cient. Sql Command = New _
Sql A i ent . Sgl Comrand( )
comBSQL. Connection = conSQL
comBQ.. CommandText ="Sel ect au_l name, au_f name from aut hors"
Di m dat Read As Sql Cl i ent. Sql Dat aReader
dat Read = commSQL. Execut eReader ( )
Do Until dat Read. Read = Fal se
MessageBox. Show( dat Read. Get String(1) & " "
& dat Read. Get String(0))
Loop
dat Read. Cl ose( )

m Retrieving Data
= Returning Multiple Result Sets

You can use the DataReader object to create a read-only, forward-only stream
of data. Thisis an eficient method for accessing data that you only need to read
through once. Y ou can improve application performance by using this object

because it holds only a single row of data at a time in memory instead of
caching the entire set of records.

There are two versions of this object:

s SglDataReader for SQL Server databases
s OleDbDataReader for other data sources

The SglDataReader object contains some methods that are not available to the
OleDbDataReader. These are GetSQL type methods that you can use to
retrieve SQL Server—specific data type columns from the data source.

Reading Data

Y ou can instantiate the DataReader object by using the ExecuteReader
method of the Command object. After you create the DataReader, you can
cal the Read method to obtain datain the rows. Y ou can access the columns by
name, ordina number, or native type in conjunction with ordinal number.

Y ou must ensure that you use the Close method of the DataReader object
before accessing any output or return parameters from a stored procedure
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The following example shows how to retrieve data by using the DataReader
object:

Dim conSQL As SqlClient.SqlConnection

conSQL = New SqlClient.SqglConnection( )
conSQL.ConnectionString = "Integrated Security=True;" & _
“"Data Source=LocalHost;Initial Catalog=Pubs;"
conSQL.Open( )

Dim commSQL As SqglClient.SqglCommand = New _
SqlClient.SglCommand( )

commSQL .Connection = conSQL

commSQL .CommandText = "Select au_lname, au_fname from authors"

Dim datRead As SqlClient.SqlDataReader
datRead = commSQL.ExecuteReader( )

Do Until datRead.Read = False
MessageBox.Show(datRead(1).ToString & " " &
datRead(0) -ToString)

Loop

datRead.Close( )

Retrieving Data

Because you will often know the data types of your return data, you can use the
Get methods to retrieve datain columns by specifying their data type. This

approach can improve application performance because no type conversion is
required, but your data and output types must be identical.

The following example shows how to use the GetString method to retrieve data.

With GetString, you no longer need the ToString method shown in the
preceding example.

Do Until datRead.Read = False
MessageBox.Show(datRead.GetString(1l) & "™ " &
datRead.GetString(0))

Loop

Returning Multiple Result Sets

Sometimes you will issue commands that return more than one result set. By
default, the DataReader will only read the first result set. Y ou can use the
NextResult method of the DataReader to retrieve the next result set into the
DataReader object. If there are no more result sets, this method returns False.

The following example shows how to create a stored procedure that returns two
result sets from a SQL Server database:

CREATE PROCEDURE MultiResult AS
Select * from authors

Select * from titles

Return O

GO
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The following example shows how to execute the stored procedure
M ultiResult and access the information contained in each result set:

Dim conSQL As SqlClient.SqlConnection

conSQL = New SqlClient.SglConnection( )
conSQL.ConnectionString = "Integrated Security=True;" & _
"Data Source=LocalHost;Initial Catalog=Pubs;"
conSQL.Open( )

Dim commSQL As SqglClient.SqlCommand = New _
SqlClient.SglCommand( )

commSQL .Connection = conSQL

commSQL .CommandType = CommandType.StoredProcedure
commSQL .CommandText = "'"MultiResult"

Dim datRead As SqlClient.SglDataReader
datRead = commSQL.ExecuteReader( )
Do
Do Until datRead.Read = False
MessageBox.Show(datRead.GetString(l))
Loop
Loop While datRead.NextResult

datRead.Close( )
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Using the DataAdapter Object

Topic Objective
To discuss how to use the
DataAdapter object.

Lead-in

The DataAdapter serves as
the link between a data
source and a DataSet Itis
used to retrieve data and
insert it into DataTable

objects for disconnected
use.

m Used As a Link Between Data Source and Cached

Tables
Di m adapt SQL As New Sqgl Cl i ent. Sql Dat aAdapter( _
"Select * from authors", conSQ)
Di m dat Pubs As Dat aSet = New Dat aSet ( )
adapt SQL. Fi | | (dat Pubs, " NewTabl e")
Mani pul ate the data locally
adapt SQL. Updat e (dat Pubs, " NewTable")

Y ou can use the DataAdapter object to exchange data between a data source
and a DataSet. You can use it to retrieve appropriate data and insert it into
DataT able objects within a DataSet, and to update changes from the DataSet
back into the data source.

Creating the DataAdapter

There are two ways to create a DataAdapter object:
= Use an existing, open Connection object.

= Open the Connection as needed

Using an Existing Connection Object

Create a Command object within a Connection object, and assign the
SelectCommand property of the previoudly instantiated DataAdapter object to
that command. This technique is useful if you need to create a Connection
object specificaly for the DataAdapter object to use.
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The following example shows how to use Connection and Command objects
to instantiate a DataAdapter:

Dim conSQL As SqlClient.SqlConnection

conSQL = New SqlClient.SglConnection( )
conSQL.ConnectionString = "Integrated Security=True;" & _
"Data Source=LocalHost;Initial Catalog=Pubs;"
conSQL.Open( )

Dim comSQL As SqlClient.SglCommand

comSQL = New SqlClient.SglCommand( )

comSQL .Connection = conSQL

comSQL .CommandText = "Select * from authors"

Dim adaptSQL As SqglClient.SqglDataAdapter
adaptSQL = New SqlClient.SqlDataAdapter( )
adaptSQL.SelectCommand = comSQL

Using a Closed Connection

Instantiate the DataAdapter object, passing a query string and a Connection
object. The DataAdapter will check whether the Connection is open, and, if it
is not open, it will open it for you and close it when your method call is
complete. This method is useful if you have aready set the properties of a

Connection object in your application and only need the connection to be
opened to populate the data tables.

The following example shows how to instantiate a DataAdapter object:

Private conSQL as SqlClient.SglConnection

Private Sub Forml_Load(ByVal sender As System.Object, ByVval e
As System.EventArgs) Handles MyBase.Load
conSQL = New SqlClient.SqglConnection( )
conSQL.ConnectionString = "Integrated " & _
""Security=True;Data Source™ & _
"=LocalHost; Initial Catalog=Pubs;"
End Sub

Private Sub Buttonl Click(ByVal sender As System.Object, ByVal
e As System.EventArgs) Handles Buttonl.Click

Dim adaptSQL As New SqlClient.SqlDataAdapter( _

"Select * from authors'™, conSQL)
End Sub
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Filling the DataTable

After the DataAdapter object is created, you use the Fill method, passing a
DataSet and, optionaly, the required DataT able name as parameters. Y ou can
then work with the datain your application, and, if required, you can use the
Update method of the DataAdapter to synchronize those changes back to the
data source.

You can useasingle DataAdapter to fill and update multiple DataSets. A
single DataAdapter is linked to a particular DataSet only when a method is
actualy being called. The following example shows how to use a DataAdapter
to fill a DataSet:

Dim conSQL As SqlClient.SqlConnection

conSQL = New SqlClient.SqglConnection( )
conSQL.ConnectionString = "Integrated Security=True;" & _
"Data Source=LocalHost;Initial Catalog=Pubs;"
conSQL.Open( )

Dim adaptSQL As New SqglClient.SqglDataAdapter(*'Select * from
authors'™, conSQL)

Dim datPubs As DataSet = New DataSet( )
adaptSQL.Fill(datPubs, "NewTable')

"Manipulate the data locally using the DataSet

adaptSQL.Update (datPubs, "NewTable'™)
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Demonstration: Retrieving Data Using ADO .NET

Topic Objective

To demonstrate how to
retrieve data from a

SQL Server database by
using ADO .NET.

Lead-in
Having reviewed the code to

retrieve data by using
ADO .NET, you will now see

the code working.

; - In this demonstration, you will learn how to retrieve data from a SQL Server
Delivery Tip database by using the SQL DataReader object in a Visua Basic .NET-based
The step-by-step. application

instructions for this ’

demonstration are in the
instructor notes for this
module.
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€ The DataSet Object

Topic Objective

To provide an overview of
the topics covered in this
lesson.

Lead-in

You have just seen how to
populate a DataSet by using

a DataAdapter. Now you to
use this object

= Disconnected Data Review

m The DataSet Object

m Populating DataSets

m Using Relationships in DataSets
= Using Constraints

m Updating Data in the DataSet

m Updating Data at the Source

DataSets are the primary object that you will work with when accessing
disconnected sets of data. They are similar in concept to groups of ADO
disconnected recordsets, but in ADO .NET, there are many enhancements,
including the ability to relate tables together.

In this lesson, you will learn how to create DataSets and populate tables within
them. Y ou will also learn how to edit these tables and propagate those changes
to the data source.

After completing this lesson, you will be able to:

n Create DataSets and popul ate tables within them.
= Edit tables within DataSets.

= Propagate changes to the data source.



20 Module 8: Using ADO .NET

Disconnected Data Review

Topic Objective

To review the concepts of
disconnected data, to
ensure understanding for
the rest of this lesson.

DAO
Connected' environment

Leag-in Disconn tRcli)on ironment
Disconnected data is an SEOMEHELTENMIOINIE
important part of
contemporary application ADO
development. Connected and
disconnected environments
COMMarshalling
ADO .NET
Disconnected architecture

XML format

Delivery Tip Each new data access technology has improved on the concept of disconnected

The slide associated with
this topic is an animated
slide.

It begins by showing only
the DAO information. The
other boxes are revealed on
subsequent mouse clicks.

data, but ADO .NET is the first one to provide a truly enterprisewide solution.

Problems with Two-Tier Applications

In traditional two-tier applications, a data source connection was often made at
the start of the application and held open until the application ended. This can
cause many problems, including:

= Poor performance

Database connections use valuable system resources, such as memory and
CPU utilization. The database server performance will be affected if alarge
number of connections are needlessly held open.

= Limited scalability

Applications that consume a large number of database connections are not
scal able because most data sources can only support a limited number of
connections.

Disconnected Data in RDO and ADO

To overcome these problems, Remote Data Objects (RDO) and ADO
introduced the concept of disconnected data. This was implemented so that you
could retrieve a set of records, disconnect from the data source, and work with
the data locally. Y ou could then reconnect and submit your changes to the
database. The Recor dsetswere marshaled between the tiers as COM objects,

requiring that both the server and client computer could handle COM
components.



Delivery Tip

Students may be concerned
that using a textbased
format for transmission may
compromise security.
Remind them that you can
use Internet standard
security measures such as
Secure Sockets Layer
(SSL), TLS, and Internet
Protocol Security (IPSec) to
ensure the privacy of data.
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Disconnected Data in ADO .NET

ADO .NET is designed for use in the I nternet world, whereas COM may not be
supported by al tiers, and may not be transmitted through firewalls. The
disconnected architecture has been updated from the previous twao tier, RDO,
and ADO architectures.

ADO .NET uses XML asits transmission format. Thisis a text-based format,
alleviating the problems associated with the transmission of COM objects and
ensuring true cross-platform interoperability.

ADO .NET provides you with a new object for the caching of data on the client
computer. This object is known asa DataSet. This object is automatically
disconnected from the data source but maintains the ability to later update the
source based on changes made at the client.
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The DataSet Object

Topic Objective
To introduce the DataSet
object.

Lead-in
The DataSet object is a
disconnected cache of data.

EEET— Collection
| Tables | Tahble

i Constraints . Constraint

[ Rows W oo
‘ Rows ‘ Row.

.
i Relations i Relation

The DataSet object is a disconnected, memory resident cache of data. It is

structured in a similar manner to a database in that it contains DataT able,
DataRelation, and Constraint objects.

DataSets

A typical use of a DataSet is through Web Services. A client application will
make arequest for data to a Web Service that will populate a DataSet (using a
DataAdapter) and return it to the client. The client can then view and modify
the DataSet by using properties and methods that are consistent with database
operations, and then pass it back to the Web Service. The Web Service will then
update the database with the clients' changes. The DataSet is transmitted
between tiers as XML, which means that it can be aso be used by non-

ADO .NET clients.

DataTables and DataRelations

The DataSet contains the Tables and Relations collections. Using objects
within these two collections, you can build up a group of related tables within
your DataSet. The DataT able object consists of the Columnscollection and
the Rows collection. Y ou can use the objects in these collections to manipulate
the fields and query their properties. The Relations collection contains
definitions of all the relationships between the DataT able objectsin the
DataSet. Y ou can use these to enforce constraints on your data or to navigate
acrosstables.

The System.Data Namespace

The System.Data namespace contains the DataSet and its objects because they
are generic ways of handling data. Unlike the Provider objects, there are not
different objects for different data sources.
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Populating DataSets

Topic Objective
To discuss how to create
and populate DataSets.

Lead-in
You can populate DataSets
in three different ways.

m Populating DataSets from an RDBMS

Di m adapt SQL As Sgl d i ent . Sgl Dat aAdapt er
adapt SQL = New Sqgl C i ent. Sql Dat aAdapt er (
"Sel ect * from authors", conSQ.)

= New Dat aSet ( )
"NewTabl e")

Di m dat Pubs As Dat aSet
adapt SQL. Fi | | ( dat Pubs,

m Programmatically Creating DataSets

Di m dat Pubs As DataSet = New DataSet ( )

Dim tbl Authors As DataTabl e = New Dat aTabl e("aut hors")

t bl Aut hor s. Col utms. Add( "Aut hor | D', System Type. Get Type
("System I nt32"))

Delivery Tip
Populating DataSets from
XML data will be covered in

the last lesson of this
module.

Because a DataSet is simply a memory resident representation of data, you do
not necessarily need to take it from atraditional data source, such as arelational
database management system (RDBMS) or a message store. Y ou can create it

at run time to manipulate data created within an application, or you can useiit to
view XML data.

Populating DataSets from an RDBMS

You use a DataAdapter to access data stored in a database, and store the data
in DataT able objects within a DataSet in your application.

The following example shows how to populate a DataT able called NewTable
with data from a SQL Server database:

Dim conSQL As SqlClient.SqlConnection

conSQL = New SqglClient.SqlConnection( )

conSQL.ConnectionString = "Integrated Security=True;" & _
"Data Source=LocalHost;Initial Catalog=Pubs;"

conSQL.Open( )

Dim adaptSQL As SqlClient.SqlDataAdapter
adaptSQL = New SqglClient.SqglDataAdapter(*'Select * from
authors'™, conSQL)

Dim datPubs As DataSet = New DataSet( )
adaptSQL.Fill(datPubs, "NewTable')
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For Your Information
The addition of data and
constraints to this table will
be covered later in this
lesson.

Programmatically Creating DataSets

Y ou sometimes need to work with non-standard data sources. In this situation,
you can programmatically create DataSets, DataT ables, DataRelations, and

Constraints, and then populate the tables with your data. This will give you the
ability to use standard ADO .NET functions to access your data

The following example shows how to create a DataSet containing a DataT able

with three DataColumns. This could then be extended to add more columns,
and then populate them with data.

Dim conSQL As SqlClient.SqlConnection

conSQL = New SqlClient.SqglConnection( )
conSQL.ConnectionString = "Integrated Security=True;" & _
"Data Source=LocalHost;Initial Catalog=Pubs;"
conSQL.Open( )

Dim adaptSQL As SqglClient.SqlDataAdapter
adaptSQL = New SqglClient.SqglDataAdapter(*'Select * from
authors™, conSQL)

Dim datPubs As DataSet = New DataSet( )

Dim tblAuthors As DataTable = New DataTable("'authors'™)
tblAuthors.Columns_Add("*AuthoriID", _
System.Type.GetType("'System. Int32'))
tblAuthors.Columns._Add(*'au_lname™, _
System.Type.GetType(*'System.String™))
tblAuthors.Columns.Add(*'au_fname®,
System.Type.GetType(*'System.String™))
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Using Relationships in DataSets

Topic Objective

To discuss how to use
DataRelations within a
DataSet to create and
maintain relationships.

Lead-in
Relationships are the basis
of an RDBMS.

m Creating Relationships

Dim rel PubsTitl e As DataRel ati on = New Dat aRel ati on(
"PubsTitl es",
dat Pubs. Tabl es(" Publ i shers"). Col ums("pub_id"),
dat Pubs. Tabl es("Titl es"). Col ums("pub_id"))

dat Pubs. Rel ati ons. Add(r el PubsTitl e)

m Accessing Related Data

Di m PubRow, TitleRow As Dat aRow, Titl eRows( ) As DataRow

PubRow = dat Pubs. Tabl es(" Publ i shers") . Rows(0)
Titl eRows = PubRow. Get Chi | dRows(" PubsTitl es")

The basis of most RDBMSs is the ahility to relate tables to each ather.

ADO .NET provides this ability within DataSets through the DataRelation
class.

Each DataRelation object contains an array of DataColumn objects that define
the parent column or columns, or primary key, and the child column or columns,
or foreign key, in the relationship. Referential integrity is maintained by the
relationship, and you can specify how to deal with related changes.
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Creating Relationships

The following example shows how to create a relationship between two
DataTable objectsin a DataSet . The same DataAdapter is used to populate
the DataT able objects, and then a DataRelation is created between the two.

Dim conSQL As SqlClient.SqlConnection

conSQL = New SqlClient.SqglConnection( )
conSQL.ConnectionString = "Integrated Security=True;" & _
"Data Source=LocalHost;Initial Catalog=Pubs;"
conSQL.Open( )

Dim adaptSQL As SqglClient.SqglDataAdapter
Dim datPubs As DataSet = New DataSet( )

adaptSQL = New SqlClient.SqglDataAdapter(*'Select pub_id," &
"pub_name, city, state from publishers', conSQL)

adaptSQL.Fill(datPubs, "Publishers'™)

adaptSQL = New SqlClient.SqglDataAdapter(*'Select pub_id," &

"title, type, price from titles”™, conSQL)

adaptSQL.Fill(datPubs, "Titles")

Dim relPubsTitle As DataRelation

relPubsTitle = New DataRelation("'PubsTitles", _
datPubs.Tables('Publishers™) ._Columns("pub_id"™), _
datPubs._Tables("'Titles") .Columns(*'pub_id™))
datPubs.Relations.Add(relPubsTitle)

Accessing Related Data

The main use of a DataRelation is to alow access to related recordsin a
different table. Y ou can do this by using the GetChildRows method of a
DataRow object that returns an array of DataRow objects. The following
example shows how to use this method to access the child rows that match the
first publisher by using the relationship created in the previous example:

Dim PubRow, TitleRow As DataRow
Dim TitleRows( ) As DataRow "Array of DataRow objects

PubRow = datPubs.Tables("'Publishers').Rows(0)
TitleRows = PubRow.GetChildRows("'PubsTitles')

Dim i As Integer
For i = 0 To UBound(TitleRows)

TitleRow = TitleRows(i)

listBox1l. Items.Add(TitleRow('title™).ToString)
Next i
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Using Constraints

Topic Objective

To explain the importance of
constraints and how to use
them.

Lead-in
Constraints are needed to
ensure the validity of data.

m Creating New Constraints
e ForeignKeyConstraints

e UniqueConstraints

m Using Existing Constraints

adapt SQL = New Sqgl Cient. Sgl Dat aAdapter ("Select title_id,
title, type, price fromtitles", conSQ)

adapt SQL. Fi | | Schema( dat Pubs, schenatype. Source, "Titles")

adapt SQL. Fi | | (dat Pubs, "Titles")

'"Edit sone data

adapt SQL. Fi | | (dat Pubs, "Titles")
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You can create your own constraints within a DataSet, or you can copy the

existing constraints from the data source. Each of these options is available to
you in ADO .NET.

Creating New Constraints

Y ou can apply two types of constraint classes to DataColumns:
ForeignKeyConstraint and UniqueConstraint.

ForeignKeyConstraint

This constraint controls what happens to a child row when a parent row is
updated or deleted. Y ou can specify different behaviors for different
circumstances. The following table shows the values for the DeleteRule and
UpdateRule properties of the ForeignK eyConstraint.

Value Description
Cascade Deletes or updates any child records based on the parent record
SetNull Sets related values to DBNull

SetDefault Setsrelated valuesto their defaults
None Does not affect related rows
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The following example shows how to apply a foreign key constraint with
specific actions between two tables in an existing DataSet. If arow in the
parent table is deleted, the child value will be set to DBNull. If arow in the
parent table is updated, the child values will be also be updated.

Dim colParent As DataColumn
Dim colChild As DataColumn
Dim fkcPubsTitles As ForeignKeyConstraint

colParent = datPubs.Tables(*'publishers'™).Columns(*'pub_id"™)

colChild = datPubs.Tables(""titles"™).Columns(*'pub_id")

fkcPubsTitles = New _
ForeignKeyConstraint(""PubsTitlesFKConstraint', colParent, _
colChild)

fkcPubsTitles_DeleteRule = Rule.SetNull
fkcPubsTitles.UpdateRule Rule.Cascade

datPubs._Tables("titles").Constraints.Add(fkcPubsTitles)
datPubs._EnforceConstraints = True

UniqueConstraint
This constraint can be added to one column or to an array of columns. It ensures
that all values in the column or columns are unique. When this constraint is

added, ADO .NET verifies that the existing data does not violate the constraint
and maintains the setting for all changes to that DataTable.

The following example shows how to add a UniqueConstraint to a column;

Dim ucTitles As UniqueConstraint

ucTitles = New UniqueConstraint('UniqueTitles", _
datPubs.Tables('titles').Columns(*'title'™))

datPubs._EnforceConstraints = True
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Using Existing Constraints

If constraints already exist in the RDBMS, you can copy them directly into your
DataSet. This can save alot of time that might be spent coding for frequently
occurring problems. For example, if you fill a DataSet, modify some data, and
then use Fill again to return to the original data, al the rows will be appended

to your existing DataTables, unless you define primary keys. You can avoid
this type of problem by copying the table schema.

The following example shows how to use the Fill Schema method to copy
congtraint information into a DataSet:

adaptSQL = New SqlClient.SqlDataAdapter(*'Select title_id,"” & _
“title, type, price from titles™, conSQL)

adaptSQL.FillSchema(datPubs, schematype.Source, "Titles™)

adaptSQL.Fill(datPubs, "Titles")

"Edit some data

adaptSQL.Fill(datPubs, "Titles")

Note Constraints are automatically added to columns when you create a
relationship between them. A UniqueConstraint is added to the primary key,
and a ForeignK eyConstraint is added to the foreign key.
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Updating Data in the DataSet

Topic Objective

To explain how to update
data in a DataSet and pass
those changes back to the
underlying data source.

Lead-in
Once you have access to

data, you are likely to want
to be able to change some

of it.

= Adding Rows

Di m dr NewRow As Dat aRow = dat Pubs. Tabl es("Titl es"). NewRow
' Popul at e col ums

dat Pubs. Tabl es("Titl es"). Rows. Add( dr NewRow)

| = Editing Rows |

dr ChangeRow. Begi nEdit ( )
dr ChangeRow("Titl e") = drChangeRow("Title").ToString & " 1"
dr ChangeRow. EndEdi t ( )

| = Deleting Data |

dat Pubs. Tabl es("Titl es"). Rows. Renove( dr Del Row)

After you have created a DataSet of DataT ables you might want to add,

update, and delete data. Any changes you make to the data are stored in
memory and later used to apply the changes to the data source.

Adding Rows

Use the following steps to add new rows to a table:

1. Instantiate a DataRow object by using the NewRow method of the
DataTable.

2. Populate the columns with data.

3. Cdl the Add method of the DataRows collection, passing the DataRow
object.

The following example shows how to add rows to a DataSet:

Dim drNewRow As DataRow = datPubs.Tables(*'Titles"™).NewRow
drNewRow(*'title™) = "New Book™

drNewRow("'type'™) = "business"

datPubs.Tables("Titles™) .Rows.Add(drNewRow)
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Editing Rows

Use the following steps to edit existing rows:

1. Cadl the BeginEdit method of the row.

2. Change the datain the columns.

3. Cdl EndEdit or CancelEdit to accept or reject the changes.

The following example shows how to edit datain an existing column:

Dim drChangeRow As DataRow = datPubs.Tables('Titles™)_.Rows(0)
drChangeRow.BeginEdit( )

drChangeRow(*'Title') = drChangeRow("Title")._.ToString & " 1"
drChangeRow.EndEdit( )

Deleting Data

Use either of the following methods to delete a row:
= Remove method

Call the Remove method of the DataRows collection. This permanently
removes the row from the DataSet.
= Deete method

Cdll the Delete method of the DataRow object. This only marks the row for
deletion in the DataSet, and calling RejectChanges will undo the deletion.

The following example shows how to delete an existing row from a DataSet:

Dim drDelRow As DataRow = datPubs.Tables(*"Titles™) _Rows(0)
datPubs._Tables("Titles™) .Rows.Remove(drDelRow)

Confirming the Changes

To update the DataSet, you use the appropriate methods to edit the table, and

then call AcceptChangesor RejectChanges for the individual rows or for the
entire table,

Y ou can discover whether any changes have been made to a row since
AcceptChanges was last called by querying its RowState property. The
following table describes the valid settings for this property.

Value Description

Unchanged No changes have been made.

Added The row has been added to the table.

Modified Something in the row has been changed.

Deleted The row has been deleted by the Delete method.
Detached Therow hasbeen deleted, or the row has been created, but

the Addmethod has not been called.
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Updating Data at the Source

Topic Objective

To discuss how to update
changes from the DataSet
to the source.

Lead-in

After you have updated your
DataSet, you will want to
replicate those changes to
the data source.

m Explicitly Specifying the Updates

Di m conm As comm CommandText = "lnsert into titles(" & _
"title_id, title, type) values(@_id, @Qitle, @ype)"

comm Par aneters. Add(" @ _i d", Sql DbType. Var Char, 6, "title_id")
comm Par aneters. Add("@itl e", Sql DbType. Var Char, 80, "title")
comm Par anet ers. Add(" @ype", Sqgl DbType. Char, 12, "type")

adapt SQL. | nsert Conmand = conmm

adapt SQL. Updat e( dat Pubs, "titles")

= Automatically Generating the Updates

Di m sqgl CommBui | d As New Sgl ConmandBui | der ( adapt SQL)
MsgBox ( sgl CormBui | d. Get | nsert Conmmand. ToSt ri ng)
adapt SQL. Updat e( dat Pubs, "titles")

After you have updated the tables in your DataSet, you will want to replicate
those changes to the underlying data source. To do this, you use the Update
method of the DataAdapter object, which is the link between DataSet and data
source.

The Update method, like the Fill method, takes two parameters: the DataSet in
which the changes have been made and the name of the DataTable in which
the changes are. It determines the changes to the data and executes the
appropriate SQL command (Insert, Update or Delete) against the source data.

Explicitly Specifying the Updates

Y ou use the | nsertCommand, UpdateCommand, and DeleteCommand
properties of the DataAdapter to identify the changes occurring in your
DataSet. Y ou specify each of these as an existing command object for an Insert,
Update, or Delete SQL statement. For any variable columns in the statements,

you use SqglParameter objects to identify the column, data type, size, and data
to be inserted.
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The following example shows how to use the | nsertCommand property to add
arow to the Titles table in the Pubs database:

Dim conSQL As SqlClient.SqlConnection
Dim adaptSQL As SqglClient.SqglDataAdapter
Dim datPubs As DataSet = New DataSet( )

conSQL = New SqlClient.SglConnection( )
conSQL.ConnectionString = "Integrated Security=True;" & _

"Data Source=LocalHost;Initial Catalog=Pubs;"
conSQL.Open( )

adaptSQL = New SqglClient.SqglDataAdapter(*Select pub_id," & _
"title_id, title, type, price from titles", conSQL)
adaptSQL.Fill(datPubs, "Titles")

Dim drNewRow As DataRow = datPubs.Tables("Titles').NewRow
drNewRow(*'title_id") = "hg3454"

drNewRow(*'title™) = "New Book™

drNewRow(*'type'™) = "business"

datPubs._Tables("'Titles™) _Rows.Add(drNewRow)

Dim comm As SqglClient.SqglCommand

comm = New SqlClient.SqlCommand( )

comm.Connection = conSQL

comm.CommandText = "Insert into titles(title_id, title, " & _
"type) values (@title_id,@title,@type)"

comm.Parameters.Add("@title_id", SqlDbType.VarChar, 6, _
"title_id")

comm.Parameters.Add("'@title', SqlDbType.VarChar, 80, "title")
comm.Parameters.Add("'@type', SqlDbType.Char, 12, "type'™)

adaptSQL. InsertCommand = comm
adaptSQL.Update(datPubs, "titles')
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Automatically Generating the Updates

If your DataTable is generated from only one table in the data source, you can
use the CommandBuilder object to automaticaly create the I nsertCommand,
UpdateCommand, and DeleteCommand properties.

The following example shows how to use the CommandBuilder object to
achieve the same results as the previous example:

Dim conSQL As SqlClient.SqlConnection
Dim adaptSQL As SglClient.SqglDataAdapter
Dim datPubs As DataSet = New DataSet( )

conSQL = New SqlClient.SqglConnection( )
conSQL.ConnectionString = "Integrated Security=True;" & _

"Data Source=LocalHost;Initial Catalog=Pubs;"
conSQL.Open( )

adaptSQL = New SqglClient.SqlDataAdapter(*'Select pub_id," & _
"title_id, title, type, price from titles", conSQL)
adaptSQL.Fill(datPubs, "Titles")

Dim drNewRow As DataRow = datPubs.Tables("'Titles"™).NewRow
drNewRow(*'title_id'") = "hg8765"

drNewRow(*'title'™) = "New Book"

drNewRow("'type'™) = "business'

datPubs.Tables('Titles') .Rows.Add(drNewRow)

Dim sqlCommBuild As New SqlCommandBuilder(adaptSQL)
adaptSQL.Update(datPubs, "titles™)

Note Even though the automatically generated commands can simplify your
coding, you will improve performance by using the I nsertCommand,
UpdateCommand, and DeleteCommand properties.
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Practice: Using DataSets

Topic Objective

To practice using DataSets.
Lead-in

In this practice, you will

update existing data in a
SQL Server database using

automatically generated
commands.

In this practice, you will update existing datain a SQL Server database by using
automatically generated commands.

I Toreview the application

1
2.

4.

Open Visua Studio .NET.

On the File menu, point to Open, and click Project. Set the location to

install folder \Practices\Mod08\DataSets\Starter, click DataSets.sln, and
then click Open.

Run the application, and click Populate DataSet and Refresh List from
Data Sour ce. Note that the list on the left displays data from a DataSet, and
the list on the right uses a DataAdapter object. Quit the application.

Review the code in Form1.vb to see how the DataSet was created.

K To update the local DataSet

1

In btnEditName_Click procedure, locate the comment “add code to update
the dataset here.”

Add the following lines below the comment to update the local dataset:

objDataTable = dsCustomers.Tables(*'customers')
objDataRow = objDataTable._Rows(iCust)
objDataRow(*'lastname'™) = strNewName
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I To automatically generate a command

1.

In btnUpdate _Click procedure, locate the comment “add code to update the
data source here.”

To generate the update command automatically, add the following lines
below the comment:

Dim sqlCommBuild As New _
SqlClient.SglCommandBui lder (adaptCustomers)
adaptCustomers.Update(dsCustomers, '‘customers'™)

I Totest your code

1.

Run the application, and click Populate DataSet and Refresh List from
Data Sour ce.

Click the first name in the L ocal DataSet box. Click Edit Name, enter your
last name, and then click OK. Click Refresh List from DataSet, and note
that the change has been made to the local dataset. Click Refresh List from
Data Sour ce, and note that the underlying data source till contains the
original data

Click Update Changes. Click Refresh List from Data Sour ce, and verify
that the changes have now been replicated to the underlying data source.
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€ Data Designers and Data Binding

Topic Objective

To provide an overview of
the topics covered in this
lesson.

Lead-in
Data binding is an important
feature of Visual Basic.

= Designing DataSets
m Data Form Wizard

m Data Binding in Windows Forms

m Data Binding in Web Forms

Data binding has been an important part of Visual Basic data development for a
long time. The tools included in Visual Basic .NET have been enhanced to

allow easier creation of data-bound forms and to take advantage of the new
featuresin ADO .NET.

After completing this lesson, you will be able to:

m Describe the data designers available in Visual Basic .NET.
m Create data-bound Windows Forms and Web Forms.
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Designing DataSets

Topic Objective

To discuss how to create
connections, commands,
and DataSets by using the
Visual Basic designers.

Lead-in
Visual Basic .NET includes

a number of designers to
simplify the process of

DataSet creation.

m DataAdapter Configuration Wizard

e Generates a DataAdapter object in the
InitializeComponent procedure for use in your code

m Generate DataSet Tool

e Generates a DataSet based on data from an existing
DataAdapter

Delivery Tip

Remind students that these
wizards just automate the
manual process that they
have learned about already.

Visual Basic .NET includes a number of designers to simplify the process of
DataSet creation. These include the Connection Wizard, DataAdapter
Configuration Wizard, and the Generate DataSet Tool.

DataAdapter Configuration Wizard

This wizard leads you through the steps needed to create a DataAdapter object
within an existing connection. Y ou can initiate the wizard by adding a
SqlDataAdapter or OleDbDataAdapter from the Toolbox to aform at design

time. It requires the following information to generate a DataAdapter object
for use in your form:

= Connection name
s Query type
SQL statement
New stored procedure
Existing stored procedure
m Details of the chosen query

Once you have created the DataAdapter, you can view the code created by the
wizard in the InitializezComponent procedure.
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This tool alows you to generate a DataSet automatically from a DataAdapter.

Generate Dataset

Generake a dataset that includes the specified tables,

Choose a dataset:

Zhoose which kablels) to add to the dataset:

[ &dd this dataset to the designer,

authors (SqlDatasdapter1)

)4

Cancel

Help

Again, once created, you can use thisDataSet in the usua way in your code.
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Data Form Wizard

Topic Objective

To explain how to use the
Data Form Wizard to
generate a data-bound form.
Lead-in

You can use the Data Form
Wizard to automatically bind
data to controls on a form.

m Information Required:
e Name of DataSet

Connection to be used

Which tables or views, and which columns within them

How to display the data

Which buttons to create

You can use the Data Form Wizard to automatically bind data to controls on a
form. Y ou can specif y to use an existing DataSet in the project, which will then
use your pre-written methods for data access, or to create a new DataSet based
on information supplied to the wizard.

If you wish to create a new DataSet, the Data Form Wizard will require the
following information:

Name of the DataSet to create
Connection to be used (you can create a new connection at this point)

Which tables or views to use (if more than one, you can aso identify the
relationship between them)

Which columns to include on the form
How to display the data (data grid or bound controls)
Whether to include navigation and editing buttons



Demonstration: Using the Data Form Wizard

Topic Objective
To demonstrate how to use
the Data Form Wizard.

Lead-in

In this demonstration, you
will learn how to use the
Data Form Wizard to create
a data-bound form from a
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new DataSet.

Dol T In this demonstration, you will learn how to use the Data Form Wizard to create
elivery Tip a data-bound form from a new DataSet.

The step-by-step

instructions for this

demonstration are in the
instructor notes for this

module.
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Data Binding in Windows Forms

Topic Objective
To discuss data binding in
Windows Forms.

Lead-in

Windows Forms data
binding allows for more
control over the appearance
of your application than
applications created with the

Data Form Wizard.

= Simple Binding

da = New Sqgl dient. Sql Dat aAdapt er (" Sel ect au_l name, " &
"au_fnanme from authors", sql conn)

da.Fill(ds, "authors")

Text Box1. Dat aBi ndi ngs. Add(" Text", _
ds. Tabl es("authors"), "au_fnane")

= Complex Binding

da = New Sqgl dient. Sql Dat aAdapt er (" Sel ect au_l name, " & _
"au_fname from aut hors", sql conn)

da.Fill(ds, "authors")

Dat aGri d1. Dat aSource = ds. Tabl es("aut hors")

If you want more control over the appearance of your forms, you can use data
binding to design them yourself.

There are two general types of binding that can be used: simple binding and
complex binding. Both can be performed at design time by using the Properties
window or at run time by using code.

Simple Binding
Y ou use simple binding to link a control to asingle field in a DataSet. For
example, you would use smple binding for a TextBox control. Using the

DataBindings property of a data-aware control, you can specify which DataSet
and which field to bind to which property.



Delivery Tip

Remind students that this
was covered in the previous
lesson.
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The following example shows how to bind datato a TextBox control:

Dim sglconn As SglClient.SglConnection

Dim da As SqlClient._SqlDataAdapter

Dim ds As New DataSet( )

sqlconn = New SqlClient.SqlConnection( )

sqlconn._.ConnectionString = "Integrated Security=True;" & _
"Data Source=LocalHost;Initial Catalog=Pubs;"

sqlconn.Open( )

da = New SqlClient.SqlDataAdapter(*'Select au_lname, " &
"au_fname from authors', sqglconn)

da.Fill(ds, "authors™™)

TextBoxl.DataBindings.Add("'Text", _
ds.Tables(*'authors'), "au_fname')
TextBox2.DataBindings.Add(*"'Text", _
ds.Tables("authors'), '"au_lname')

Complex Binding

Y ou use complex binding to link a control to multiple fields in a DataSet. For
example, you would use complex binding for a DataGrid control. These

controlshavea DataSource property that allows you to specify the table to be
used.

The following example shows how to use the DataSour ce property of a
DataGrid control:

Dim sglconn As SglClient.SqglConnection

Dim da As SqlClient._SqglDataAdapter

Dim ds As New DataSet( )

sqlconn = New SqlClient.SqlConnection( )

sqlconn._ConnectionString = "Integrated Security=True;" & _
"Data Source=LocalHost;Initial Catalog=Pubs;"

sqlconn.Open( )

da = New SqglClient.SqlDataAdapter(*'Select au_lname, " &
"au_fname from authors', sqglconn)

da.Fill(ds, "authors™™)

DataGridl.DataSource = ds.Tables(*authors')

Updating Data
As with manual coding of data access, changing values in data-bound forms
only applies to the local DataSet. To write these changes to the underlying data

source, you must add your own code by using the Update method of the
DataAdapter.
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Data Binding in Web Forms

Topic Objective
To discuss how to use data
binding in Web forms

Lead-in
Few Web applications can
function without some sort

of data display.

= Binding to Read-Only Data

Di m sql Conm As New Sqgl Cli ent. Sql Command("Sel ect * from" &
"aut hors", sgl conn)

Di m sql Reader As Sqgl Cl i ent. Sql Dat aReader

sql Reader = sql Conm Execut eReader

Dat aGri d1. Dat aSource( ) = sql Reader

Dat aGri d1. Dat aBi nd( )

Most data displayed on Web Forms will be read only, so you do not need to
incorporate the overhead of using a DataSet in your Web Form applications;
you can use the more efficient DataReader object instead. If you want your

users to be able to edit data on the Web Form, you must code the edit, update,
and cancel events yourself.

Binding to Read-Only Data

You use the DataBind method of the DataGrid server control to bind datato a

grid on a Web Form. The following example shows how to do this using a
DataReader object:

Dim sglconn As SglClient.SqglConnection

Dim da As SqlClient.SqlDataAdapter

Dim ds As New DataSet( )

sqlconn = New SqlClient.SqlConnection( )

sqglconn.ConnectionString = "Integrated Security=True;" & _
"Data Source=LocalHost;Initial Catalog=Pubs;"

sqlconn.Open( )

Dim sqlComm As New SqglClient.SqlCommand(*'Select * from " &
"authors', sqlconn)

Dim sqlReader As SqglClient.SqlDataReader

sqlReader = sqlComm.ExecuteReader

DataGridl.DataSource( ) = sqlReader

DataGridl.DataBind( )

The DataGrid will not be visible until you call the DataBind method.



€ XML Integration

Topic Objective

To provide an overview of
the topics covered in this
lesson.

Lead-in
XML is tightly integrated into
the .NET platform.
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= Why Use Schemas?

m Describing XML Structure

m Creating Schemas

m Using XML Data and Schemas in ADO .NET

m DataSets and XmlIDataDocuments
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Delivery Tip

This lesson assumes that
students have reasonable
knowledge of XML and an
awareness of its associated
technologies.

You may find that you need
to provide more background
information if students are
not familiar with these
concepts.

Traditionally, XML and ADO data have been two distinct entities, but
ADO .NET brings them together and allows you to work with both typesin the

sameway.

XML istightly integrated into the .NET platform. Y ou have aready seen how
DataSets are transmitted by using XML format, and now you will learn how
DataSets are literally represented as XML and how their structure is defined in
an XML Schema Definition (XSD).

After completing this lesson, you will be able to:

Describe what an XML schemasis.

Create schemas.

Manipulate XML data within an ADO .NET DataSet by means of an
XMLReader.

Explain why XML schemas are useful to the Visual Basic .NET developer.
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Why Use Schemas?

Topic Objective

To discuss XML schemas
and the role they can play in
Visual Basic .NET.

Lead-in

XML schemas are an
essential part of the
developer’s tool kit.

m Define Format of Data
m Use for Validity Checking
m Advantages over DTDs

e XML syntax

e Reusable types

e Grouping

When working with traditional database applications, you often need to write
validation code to ensure that the data you are inputting matches the database
schema. If you do not do this, then you need to write error-handling code for
the potential errors that may occur. Either way, there must be some way of
checking. The solution to this problem when you are working with XML datais
XML schemas.

XML schemas are similar in concept to database schemas. They define the
elements and attributes that may appear in your XML documents, and how
these elements and attributes relate to each other. Schemas are very important
to ensure that the data you are using conforms to your specification. When
loading XML data, you can check it against the schema to validate that none of
the data entering your system isin an incorrect format. This is becoming more
of an issue as business-to-business and business-to-customer commerce
becomes more prevaent in the Internet world.
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Visua Studio .NET uses XSD to create schemas. This syntax is currently at

working-draft status at the World Wide Web Consortium (W3C), but it has
many advantages over document type definitions (DTDs).

- - = XML syntax
Delivery Tip
If students are not familiar DTDs are written using aDTD syntax, which is not related to any of the
with DTDs, do not spend too other Internet standards currently in use. XSD uses XML syntax, which
much time justifying the use enables devel opers to validate data without needing to learn yet another
of a new technology to language.
them.

s Reusable types

XSD allows you to define complex data types and reuse those within your
schema.

= Grouping

Y ou can specify that a set of elements always exists as a group and stipulate
the order in which they must appear.
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Describing XML Structure

Topic Objective

To explain how a schema
document describes XML
data.

Lead-in
So, what is contained in the
schema document?

m Schemas Can Describe:

Elements in the document

Attributes in the document

Element and attribute relationships

Data types

The order of the elements

Which elements are optional

Schemas describe the structure of an XML document, and you can use them to

validate data within that document. A schema document can describe all or
some of the following:

Elements and attributes contained within the XML document
Element and attribute relationships

Datatypes

The order of the elements

Which elements are optional

For example, consider the following XML document;

<?xml version="1.0" ?>
<pubs>

<Publishers>
<pub_id>0736</pub_id>
<pub_name>Lucerne Publishing</pub_name>
<city>Boston</city>
<state>MA</state>
<country>USA</country>
</Publishers>
<Publishers>
<pub_id>0877</pub_id>
<pub_name>Litware, Inc.</pub_name>
<city>Washington</city>
<state>DC</state>
<country>USA</country>
</Publishers>

</pubs>
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This document consists of a <pubs> element containing individual
<Publishers> elements. Each of these contains a <pub_id>, <pub_name>,
<city>, <state>, and <country> element. This defines the structure of the
document.

After the XML document is linked to a schema document describing the
structure, the schema can be used to verify data being input into the document.

The following example shows the schema generated for this document:

<xsd:schema id=""pubs"
targetNamespace=""http://tempuri.org/Publishers._xsd"
xmlns="http://tempuri.org/Publishers.xsd"
xmlns :xsd="http://www.w3.0rg/2001/XMLSchema"*
xmIns:msdata=""urn:schemas-microsoft-com:xml -msdata"
attributeFormDefault="qualified"
elementFormDefault=""qualified">
<xsd:element name=""pubs" msdata: IsDataSet=""true"
msdata:EnforceConstraints="False">
<xsd:complexType>
<xsd:choice maxOccurs="unbounded">
<xsd:element name="Publishers'>
<xsd:complexType>
<xsd:sequence>
<xsd:element name="pub_id"
type="'xsd:string" minOccurs="0" />
<xsd:element name="pub_name"
type="'xsd:string"” minOccurs="0" />
<xsd:element name="‘city"
type="'xsd:string"” minOccurs="0" />
<xsd:element name="state"
type=""xsd:string"” minOccurs="0" />
<xsd:element name="country"
type=""xsd:string"” minOccurs="0" />
</xsd:sequence>
</xsd:complexType>
</xsd:element>
</xsd:choice>
</xsd:complexType>
</xsd:element>
</xsd:schema>
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Creating Schemas

Topic Objective

To discuss how to

create schemas in

Visual Basic .NET.
Lead-in

Schemas can be generated
automatically, or they can
be explicitly created.

m Creating Schemas from Existing XML Documents
m Creating Schemas from Databases
m Working with Schemas

= Validating XML Documents Against Schema

Schemas are automatically generated for you when you work with DataSets.
You may find that there are situations when you want to create your own. One
example would be when you are exchanging data with a business partner and
want to define the structure of that data.

Creating Schemas from Existing XML Documents

You can add an existing XML document to a project and automatically create a
schema based on the contents of the document.

When you are working with XML data, an XML menu becomes available. This
menu allows you to generate schema and validate data against the schema.

When you create schemas from existing documents, all data types are declared
as strings. You can ater this manualy in the XML Designer.

Creating Schemas from Databases

Y ou can aso create an XSD schema from the structure of existing data. To do
this, you add a new schema item to your project and drag on the chosen tables
or views from the hierarchy displayed in the Data Connections of Server
Explorer. Again, the data types will need editing.
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Working with Schemas

You can view schemas in Visua Studio .NET either as XML or in the Designer
Window, which is a user-friendly display of the schema. In this window, you
can edit existing schemas (adding, removing, or modifying elements and
attributes) and create new schemas.

The following illustration shows the Designer Window:

Formi.vh [Design] | Publishers.xml  Publishers.xsd | 9Bk X

ublishers
E pub_id skring =
E pub_name skring
E city skring
E state string -
E counkry skring -

O Dataset | B #ML |

Validating XML Documents Against Schema

Y ou can use the XML Designer to validate data against XML schema. If you
have an existing document that you are adding data to, you can use this

technique to validate that the new data conforms to the structure described in
the schema.

Use the following steps to validate an XML document against an XML schema.

1. Load the XML document into the XML Designer.
2. Onthe XML menu, click Validate XML Data.

Any validation errors will be noted in the Task List.
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Using XML Data and Schemas in ADO .NET

Topic Objective

To discuss how to load XML
data into an ADO .NET
DataSet.

Lead-in

Accessing XML data by
means of ADO .NET solves
an issue that developers
have had in the past.

= Loading XML Data into a DataSet

Di m dat XML As DataSet = New Dat aSet ()
dat XML. ReadXm ("c: \ publishers.xm ")
MessageBox. Show( dat XM_. Tabl es(0) . Rows(0) (0). ToStri ng)

m Using a Typed DataSet
e Increases performance

o Simplifies coding

MessageBox. Show( pubs. Publ i shers(0). pub_id)

One of the issues experienced by developers in the past has been trying to
manipulate XML data within their applications. In earlier data access
technol ogies, there was no ability to do this. In ADO .NET, you can populate a

DataSet from an XML document. This alows you to access the datain a
simple fashion.

Loading XML Data into a DataSet

You can load an existing XML document into a DataSet by using the

ReadXML method of the DataSet. This reguires one argument of the fully
guaified path and file name of the XML document to be loaded.

The following example shows how to |oad the data and display the first column
in the first row:

Dim datXML As DataSet = New DataSet( )
datXML.ReadXml (**c: \publishers.xml™)

Dim drFirstRow As DataRow = datXML.Tables(0).Rows(0)
MessageBox.Show(drFirstRow(0) .ToString)
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Using Typed DataSets

DataSetscan be typed or untyped. A typed DataSet is smply a DataSet that
uses information in a schema to generate a derived DataSet class containing
objects and properties based on the structure of the data.

You can create atyped DataSet by using the Generate DataSet command
from the schema view. You can add a DataSet object to aform, and link it to
the typed dataset already in the project, and then work with the DataSet in the
usua way.

In untyped DataSets, you have been accessing the columns and rows as
collections in the hierarchy. In atyped DataSet, you can access these directly
as objects, as shown in the following example:

MessageBox.Show(pubs.Publishers(0) .pub_id)

Typed DataSets aso provide compile-time type checking and better
performance than untyped DataSets.

Note DataSets created using the XML Designer tools are automatically typed.
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DataSets and XmIDataDocuments

Topic Objective

To provide an overview of
the relationship between
DataSets and
XmlIDataDocuments.

Lead-in
XML developers have

traditionally used the XML
DOM to manipulate their

XML documents.

XSLT, X-Path, Controls, Designers,
Schema, DTD, etc. Code Generation
A N
| XmIDataDocument |¢—2/ DataSet |
y y y
XmlReader | XmlIReader | | Managed Provider|
4 y y

XML Documents XML Documents Data Source

Delivery Tip

This topic is not meant b
cover how to use
XmlDataDocuments but to
simply provide an overview
of the link with DataSets.

XML developers have traditionally used the Document Object Model (DOM) to
manipulate their XML documents. Thisis a standard COM interface to XML

data, and it allows access to the elements and attributes contained within the
document.

The XmIDataDocument in the .NET Framework extends the DOM Document
object inthe XML DOM to alow .NET developers to use the same

functionality. This object is tightly integrated with the ADO .NET DataSet, and
loading data into either object synchronizes it with the other.

Any manipulation of data by means of the DataSet or the XmIDataDocument
is synchronized in the other. Therefore, if you add arow to the DataSet, an
element is added to the XmlDataDocument, and vice versa.
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Demonstration: Using XML Schema

Topic Objective

To demonstrate using XML
documents by means of
DataSets.

Lead-in

This demonstration will
show you how to use an
XML schema to validate and
XML document.

In this demonstration, you will learn how to create an XML schema from an

existing XML document, and how to then use the schemato validate the
document.
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Lab 8.1: Creating Applications That Use ADO .NET

Topic Objective

To introduce the lab.
Lead-in

In this lab, you will use

ADO.NET to access data.

o,
~>

| Explain the lab objectives.

| Objectives

After completing this lab, you will be able to:

= Retrieve, insert, and update data by using ADO .NET.
» Use data binding on a Web Form.
s Usethe XML Designer to create a typed dataset.

Prerequisites

Before working on this lab, you must be familiar with:

m Creating Visual Basic .NET Windows Forms and Web Forms.
» Using ADO .NET data readers.

= Using ADO .NET DataSets.

= Working with XML and XSD.

Scenario

In thislab, you will use ADO .NET to access data for the Cargo application.
Y ou will create both Windows Forms and Web Forms that access both
customer and invoice information. Y ou will also use the XML Designer to
create a typed DataSet.

Starter and Solution Files

There are starter and solution files associated with this |ab. The starter files are

in the install folder\Labs\L ab081\Starter folder, and the solution files are in the
install folder\Labs\L ab081\Solution folder.

Estimated time to complete this lab: 60 minutes



Exercise 1
Retrieving Data
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In this exercise, you will create a Windows Forms application to display alist
of customers and thar details. You will create a DataSet object in a class
module and use this data set to obtain the customer details for the selected
customer.

K To create the project
1. Open Visua Studio .NET.

o > 0w N

On the File menu, point to New, and then click Project.
Inthe Project Types box, click Visual Basic Projects
In the Templates box, click Windows Application.

Change the name of the project to Customer Project, set the location to
install folder\Labs\Lab081\Ex01, and then click OK.

£ To create the Windows Form

1.
2.

In Solution Explorer, rename the default form to frmCustomer.vb.

In the Properties window, change the Text property of the form to
Customer Details and change the Name property to frmCustomer.

Open the Project Property Pages dialog box, and change the Startup object
to frmCustomer.

Add controls to the form, as shown in the following illustration.

i)

IC

|
Company
|

Email

Addiess
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5.

6.

Set the properties of the controls as shown in the following table.

Control Property name Property value
ListBox1 Name IstCustomers
Labell Name IblID
Text ID
TextBox1 Name txtID
Text <empty>
Label2 Name IblICompany
Text Company
TextBox2 Name txtCompany
Text <empty>
Label3 Name IbIEmail
Text Email
TextBox3 Name txtEmail
Text <empty>
Label4 Name IblAddress
Text Address
TextBox4 Name txtAddress
Text <empty>
Multiline True
SizeHeight 32
Save the project.

I To create the Cargo class

1
2.
3.

On the Project menu, click Add Class.
Rename the class Car go.vb, and then click Open.

At the top of the class, add an I mportsstatement to reference the
System.Data.SqlClient namespace.

Inthe Cargo class, create private class-level variables, using the
information in the following table.

Variable name Type

dstCargo DataSet

conCargo SglConnection
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IZ To create the connection
1. Create a constructor for the class.
2. Instantiate the conCargo Connection object.

3. Using the information in the following table, set the ConnectionString
property of conCargo.

59

Name Value
Data Sour ce localhost
Initial Catalog Cargo
Integrated Security True

£ To create the GetCustomers method

1. Create amethod called GetCustomer s for the class. The method takes no
arguments and has no return value.

2. Inthis method, declare and instantiate a SglDataAdapter object caled
adpCust. Pass the following information to the constructor.

Argument Value

sdectCommandT ext Sdect Customer I D, FirstName, L astName,
CompanyName, Email, Address from Customers

selectConnection conCargo

3. Instantiate the DataSet object.
4. Usethe Fill method of adpCust to pass the following information.

Argument Value
dataSet dstCargo
srcTable CustTable

I To create the CustList property

1. Define aread-only property called CustList that returnsa DataT able.
2. Inthe Get clause, return the CustTable table from dstCargo.

3. Save and build the project.
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I To populate the list box

1.

Open the frmCustomers Code Editor.

2. Declare and instantiate a private class-level variable called objCargo of type

Cargo.
Create the frmCustomers_L oad event handler.

4. Call the GetCustomers method of the objCargo object.

6.

Add the following code to loop through the customers and populate the list
box:

Dim CurRows( ) As DataRow, CurRow As DataRow

CurRows = objCargo.CustList.Select( )

For Each CurRow In CurRows
IstCustomers. Items.Add(CurRow(*'FirstName').ToString & _
" " & CurRow(''LastName').ToString)

Next

Cadll the SetSelected method of IstCustomer to select the first item in the list.

£ To populate the text boxes

1
2.

Create the IstCustomers_Selectedl ndexChanged event handler.

Declare an I nteger variable called RowNum, and then store the
Selectedl ndex property of the list box in the variable.

Declare a DataRow variable caled CurRow, and then store the row
identified by RowNum in it by using the following line of code:

objCargo.CustList.Rows(rowNum)

Using the information in the following table, populate the text boxes with
data from this row.

Text box Column name
txtID CustomerID
txtCompany CompanyName
txtEmail Emai
txtAddress Address

Save the project.

I Totest the application
1. On the Build menu, click Build, and resolve any build errors.

2. On the Debug menu, click Start. Y ou should see that the list box and text

boxes are populated with data.

Click on a different customer in the list and verify that the text boxes
display the relevant data.

4. Quit the application.

Quit Visual Studio .NET.
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In this exercise, you will extend the class created in the previous exercise to
allow editing of data. The form in the starter file has been modified to make the
text boxes read-only by default and to include a button that you will code to test
the functionality.

I To preparetheform
1. Open Visual Studio .NET.
2. Onthe Filemenu, point to Open, and then click Project.

3. Set the location to install folder\Labs\Lab081M\ExO2AStarter, click
Customer Project.sln, and then click Open.

4. In the frmCustomer.vb code window, locate the btnEdit_Click procedure
and write code to set the ReadOnly property of the following textboxesto
False

txtCompany
txtEmail
txtAddress

£ To update the DataSet
1. Open the code window for Cargo.vb.

2. Create anew public method called EditDetailsthat takes the following
parameters by value and has no return value.

Parameter name Type

RowNum I nteger
ID I nteger
str Company String
strEmail String
strAddress String

3. Using the information in the following table, declare and initialize a variable.

Name Type Initialization Value

editRow DataRow dstCargo.Tables(*“custtable’).Rows(RowNum)

4. Call the BeginEdit method of the editRow object.
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5. Update the data in the DataSet with the arguments passed to the procedure.
Use the information in the following table.

editRow item Argument
CompanyName strCompany
Email strEmail
Address strAddress

6. Cdl the EndEdit method of the editRow object.

£ To update the underlying data

1. Using the information in the following table, declare and instantiate a
variable

Name Type Construction Value

commUpdate SglCommand  “Update customers set
CompanyName= @company,
email=@email, address=@address
where customerid=@id", conCargo

2. Usethe Add method of the command’ s Parameter s collection to create
parameters for this command. Use the information in the following table.

name dbType size sour ce column
@id SqlDbType.Int 4 CustomerID
@company SqIDbTypeVarChar 50 CompanyName
@email SqIDbTypeVarChar 255 Email
@address SqIDbTypeVarChar 255 Address

3. Inthe GetCustomers procedure, locate the declaration for adpCust.

4. Remove the declaration for adpCust (leaving the instantiation code), and
then declare adpCust as a class-levd variable.

5. Inthe EditDetails procedure, set the UpdateCommand property of
adpCust to the commUpdate command.

6. Cal the Update method of adpCust, and pass it the existing DataSet and
DataTable.
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£ To call the EditDetails method

1. Open the frmCustomer.vb code window, and create a handler for the
btnSave Click event.

2. Add codeto call the EditDetails method of the objCargo object to pass the
appropriate parameters. Use the information in the following table.

Parameter Value

RowNum IstCustomer s.Selectedl ndex
ID txtID.Text

strCompany txtCompany.Text

strEmail txtEmail . Text

strAddress txtAddress.Text

3. Set the ReadOnly property of the following textboxesto True.
txtCompany
txtEmail
txtAddress

I Totest your code
1. Run the application.

2. Click Edit Details, replace the company name with Microsoft, and then
click Save.

Quit the application.

Run the application again, and verify that the changes have been saved.
Quit the application.

Quit Visua Studio .NET.

S
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Exercise 3

Using Data Binding in Web Forms

In this exercise, you will create a Web Form that displaysinvoice datain a
bound data grid by using a DataReader object.

K Tocreatethe project

o > wDnh e

Open Visua Studio .NET.
On the File menu, point to New, and then click Project.

Inthe Project Types box, click Visual Basic Project.
In the Templates box, click ASP.NET Web Application.

Change the name of the project to Invoices, set thelocation to
http://localhost/2373/L abs/L ab081/Ex03, and then click OK.

£ To createthe Web Form

1.
2.

3.
4.

Open the design window for WebForm1.aspx.

In the Properties window, click DOCUMENT, and change the title

property to Cargo Invoices. Thiswill alter the text in the Internet Explorer
title bar.

From the Toolbox, add a DataGrid control to the form.
Save the project.

£ To create the connection

1.

Open the code window for WebForm1.aspx.

2. Add an Imports statement to accessthe System.Data.SqlClient namespace.

3. Locate the Page L oad procedure, and declare a procedure-level variable,

o

using the information in the following table.
Name Type

sglConn SglConnection

. Instantiate the connection object, and then set the ConnectionString

property, using the information in the following table.

Name Value
Data Sour ce localhost
Initial Catalog Cargo
Integrated Security True

Cadll the Open method of the connection object.
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£ To bind the data

1. Inthe Page L oad procedure, declare and instantiate a SgqlCommand object
caled comlnvoices, and pass the parameters listed in the following table.

Parameter Value
cmdText Select * from Invoices
Connection sglConn

2. Declare a SqlDataReader object called drlnvoices.

3. Cdl the ExecuteReader method of the command object, and store the
results in drlnvoices

4. Set the DataSour ce property of the DataGridto drlnvoices
5. Cadl the DataBind method of the DataGrid.

I Totest your code

Run the application and verify that the invoices are displayed in a grid on
the Web Form.
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Exercise 4

Creating Typed DataSets

In this exercise, you will create an XSD schema from the Invoices table of the
Cargo database and use it to create a typed dataset for use in a Windows Form.

I To create the project

o > wDnh e

Open Visua Studio .NET.

On the File menu, point to New, and then click Project.
Inthe Project Types box, click Visual Basic Project.
In the Templates box, click Windows Application.

Change the name of the project to InvoiceApp, set the location to
install folder\Labs\Lab081\Ex04, and click OK.

£ To create the connection

1.

In Server Explorer, right-click Data Connections, and then click Add
Connection.

Inthe Data Link Properties dialog box, enter the following information,
and then click OK.

Setting Value

Server name localhost

Security Windows NT Integrated Security
Database name Cargo

£ To create the schema

1.

Inthe Project Explorer, click InvoiceApp. On the Project menu, click
Add New |tem.

Inthe Templates box, click XML Schema, rename the item to
InvSchema.xsd, and then click Open.

In Server Explorer, expand the connection that you just created, expand
Tables, and then click I nvoices

4. Drag Invoices onto the Schema Designer.

Review the schema in both XML view and Schema view.

£ To create the DataSet

1.
2.

In Schemaview, on the Schema menu, click Gener ate DataSet.

In Solution Explorer, click Show All Files and expand | nvSchema.xsd.

Y ou will see that an InvSchema.vb file has been created containing code to
generate atyped DataSet.

Review the code in InvSchema.vb.
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£ To create the form

1.
2.

Open the design window for Form1.vb.

Add three Labels, three TextBoxes, and a Button to the form. Use the
information in the following table to set their properties.

Control Property Value
Labell Name IblInvoicel D
Text Invoice ID
Label2 Name IblICustomerID
Text Customer ID
Label3 Name IblAmount
Text Amount
TextBox1 Name txtlnvoicel D
Text <empty>
TextBox2 Name txtCustomer|D
Text <empty>
TextBox3 Name txtAmount
Text <empty>
Button Name btnFill
Text Fill

From the Data tab of the Toolbox, add a DataSet control to the form, using
the information in the following table.

Setting Value
Type of DataSet Typed
Name InvoiceApp.lnvSchema

£ To populate the DataSet

1.
2.

Create an event handler for the btnFill_Click event.

Declare and instantiate a SQL Client.SglConnection object called sglConn
using the information in the following table.

Name Value
Data Source localhost
Initial Catalog Cargo
Integrated Security True

Call the Open method of sglConn.

4. Declare and instantiate a SQL Client.SglDataAdapter object called

sqlAdapt using the information in the following table.

Parameter Value

selectCommandT ext Select * from Invoices
selectConnection sglConn
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5.

Declare and instantiate a variable, using the information in the following
table.

Name Type

invTable InvSchema.l nvoicesDataT able

Call the Fill method of sglAdapt, passing the following parameters.

Parameter Value
DataSet InvSchemal
srcTable invT able.TableName

I To populate the textboxes

1.

In btnFill_Click, add code to populate the textboxes with the appropriate
data. Use the information in the following table.

Control Text property

txtInvoicelD InvSchemal.l nvoices(0).Invoicel D
txtCustomer|D InvSchemal.l nvoices(0).Customer I D
txtAmount InvSchemal.l nvoices(0).Amount

2. Build and save the project.

£ Totest your code
1. Run the application.
2. Click Fill, and verify that the textboxes are correctly populated with data.

3. Quit the application, and quit Visua Studio .NET.
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= ADO .NET Overview

= .NET Data Providers

m The DataSet Object

m Data Designers and Data Binding

= XML Integration

1. Statethree benefits that ADO .NET has over earlier data access

technologies.

Itispart of the NET Framework, it is designed for disconnected data,
and it isintegrated with XML.

. You have the following code in your application. What would you do to

make the code more efficient? Why?

Dim sqlConn As New SqlClient.SqglConnection("'Integrated
Security=True;Data Source=LocalHost;Initial Catalog=Pubs;")
sqlConn.Open( )

Dim sqlAdapt As New SqlClient.SqglDataAdapter(*'Select
au_lname from authors™, sqlConn)

Dim sqlDataSet As New DataSet( )

sqlAdapt.Fill(sglDataSet, "Authors')

Dim i As Integer

For 1 = 0 To sqglDataSet.Tables("'Authors') .Rows.Count - 1
MessageBox.Show(sqglDataSet.Tables("'Authors'™) .Rows(i). Item(0
) .ToString)

Next

Y ou should replace the DataSet with a DataReader because a
DataReader is more efficient for read-only, forward-only data access.

Thisis because a DataReader only holds one record in memory at a
time.
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3.

If you change the contents of a DataTable in a DataSet, will those changes
be reflected in the underlying data source? Why, or why not?

The changes will only be reflected if you explicitly call the Update

method of the DataAdapter. If you do not do this, the changes are made
locally in the DataSet, which has no permanent connection to the source.

Y ou have the following code in the Page L oad event of a Web Form, but

the DataGrid does not appear. What is wrong, assuming all objects are
correctly declared and instantiated?

sqlReader = sqglComm.ExecuteReader

DataGridl.DataSource( ) = sqlReader

You have neglected to call the DataBind method of the DataGrid, as
shown in the following line of code:

DataGridl.DataBind( )

Write the code to load an XML document called Books.xml into a DataSet.

Dim ds As New DataSet( )
ds.ReadXml ("'books . xml'")



